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INTRODUCTION 
 

Problem 

Due to climate change, global sea levels are rapidly rising. Coastlines around the world will change, causing 
large-scale economic disruption as cities are abandoned. It is important to establish a method to simulate 
what cities and how many people will be displaced as this occurs. 

 

Objective 

This project attempts to establish a quantifiable estimate for how changing sea levels will affect the world’s 
population. It will initially focus on the British Isles but may be refocused later as processing time and data 
restraints become more apparent. The principal method is to use the “Raster Calculator” tool to adjust an 
elevation file to represent a new sea level. This can then be used to create a new coastline, which in turn, is 
used to query the containment of city data. Those cities that were originally contained by the coastline but 
are not any longer will then be and their total population estimated.  
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DATA EVALUATION 
 

What was needed? 
 

(Things to be considered when picking data in bullet points) 

A file containing population data for the British Isles. 

 Resolution 
 Density or Absolute values? 

A raster file containing elevation data for the British Isles.  

 Resolution 
 Time of collection 
 Accuracy 

A file containing data on cities in the British Isles. 

 Names 
 Locations 

An outline of the British Isles. 

 As well matching other the raster files limits as possible 
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Choosing Population Data 
 

Population data proved to be hard to come by for the British Isles. The two best sources seemed to be either 
ERSI’s database in the form of a disk or from the UK Data Service.  

ERSI NUTS3 Data 

The ERSI NUTS3 data came in the form of polygons representing population density (persons per square 
kilometer). Unfortunately the polygons represented a large ranges of values (i.e. 351-1,000). These would have 

needed to be converted in to discrete values for the purpose of population displacement calculations. To do 
this, the value of each polygon would need to be replaced by the median value of its range, which would 
introduce significant error to the results. Even more error would be introduced for the unbounded 1,000+ 
persons per sq. km polygons. The data is also not in a raster format. As a result, the change in area of each 
polygon would need to be calculated independently for each increment in sea level. This would make the 
calculations extremely time consuming.  

 

Figure 1: The ERSI population data in ArcMap. The large geographical 
areas and range of values for each Population density can be seen in the 
table of contents and on the map.
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UK Data Service Data 

The UK data service had data in the form of population per district that was available for download in data 
tables. There was also corresponding district outline shapefiles available separately. It was possible that the 
shape files could have been loaded and the data tables joined to them. However, the size of these districts 

where very large, this meant that the resolution and accuracy of calculations would be poor. 

ERSI City Populations 

After exploring the ERSI city data it became apparent that all urban areas were grouped by population (Figure 
2). Although the ranges of these populations varied it seemed that this data would make for more accurate 
results than any of the other population data. Especially since the project is particularly concerned with 
urban areas. Though, it is worth noting that if better population data could be found such as that which is 
available for the US, accuracy would likely be improved by a significant factor.  

 

 

Figure 2:  The attribute table for “Medium Cities” in Europe focusing on some of those that fall within the UK.  Highlighted 
in orange is an example, Oxford, showing that the data table contains a “POP_CLASS” column with the value 100,001 – 
500, 000 people (Defining a “Medium City”)
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Choosing Elevation Data 
 

USGS Earth Explorer 

The best resolution that could be feasibly obtained for such a project was 60x60m cells using ASTER Global 

DEM data. Additionally this data had vertical (root-mean-squared-error) accuracies generally between 10- 
and 25-meters.  However, GTOPO 30 data with a grid spacing of 30 arc seconds (~1km) is much easier to work 
with, since the file sizes are smaller and you can obtain the coverage needed using fewer files. Both types of 
data could be obtained from the USGS EarthExplorer website (Figure 3). 

 

The ASTER data required many more files than GTOPO30; 82 compared to 1 respectively (Figure 3). For this 
reason the GTOPO 30 file was initially used. However, there was clear resolution issue. When the GTOPO 30 
raster was viewed above the population density raster there were significant populated areas that showed as 
being outside the coverage of the raster (Figure 4). This meant that the calculations would show some 
amount of the population had been displaced by the ocean prior to any sea level change. Though, it is 

Figure 3: The USGS Earth Explorer page where data was 
sourced (above). The data acquisition date and number of 
files needed for coverage in ASTER Global DEM (right).
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possible to correct for this by adding cells to the raster (i.e. adding cells such that there is a cell over all parts 
of the ERSI outline and giving them a value of 0.1). This would introduce further errors, by assuming that the 
values do not change abruptly at the coast, such as is associated with cliffs.  

 

Due to these reasons the ASTER data was used despite the additional data acquisition and preparation time.  

 

 

 

  

 

Figure 4:  A screenshot of the south coast showing the resolution of the GTOPO30 raster (the grey cells). The colored polygons 
represent the ERSI population data and the yellow polygon represents the British Isles (ERSI Data). In some places, significant 
populations (consider the orange square is a square kilometer) would already be considered at sea level, since areas without a cell 
representing them are considered as such in this dataset. 
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Choosing City Data 
 

ERSI 

The ERSI data mentioned earlier in “choosing population data”, also contained city data (Figure 5 and 6). It 
was from a reputable source and contained names and positions of cities in the British Isles. For the purpose of 
using cities for reference points this data was more than sufficient.  

 

 

 

 

 

 

 

 

 

Figure 5:  A screenshot of the ERSI data showing the British Isles. As you zoom in and out of the image various cities and towns 
become visible.  These are also categorized by size as shown in Figure 6.
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Choosing an Outline  
 

The outline can be extracted from the “Country Outlines” layer which contains an outline titles “United 
Kingdom of Great Britain” (Figure 7). 

  

 

 

 

 

Figure 6:  A zoomed-in screenshot of the ERSI data showing more cities yet still nowhere near the full extent of city/town data. 
Included is also the areas covered by these cities rather than just points. This means that as the coastline changes it will be possible 
to see the extent to which a city has been submerged as opposed to considering it a point. Also included, outlined in orange, is a 
window showing how the urban areas are grouped. This may be useful later when trying to display the data selectively.

Figure 7: A screenshot 
showing the “United 
Kingdom” within the 
attribute table for 
“Country Outlines” in 
the TOC. From here this 
data could be extracted 
to create a new layer 
file of the UK outline.  
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DATA ANALYSIS 
Refocusing the Project 
 

Having collected all the data it has become apparent that within the given time constraints it is not feasible to 
perform this task for the entire British Isles. Instead, the same data files will be applied to a smaller scale 
region of interest, The Isle of Wight (Figure 8).  

 

Figure 8:  An image showing 
the location of the Isle of 
Wight with respect to the 
British Isles. 

11 
 



To implement this change in area of interest an outline for the Isle of Wight needs to be sourced. This can be 
done by exploding the “Country Outline” for the “United Kingdom of Great Britain” (Figure 7) using the 
“Explode Multipart Feature” tool ( ) (Page 17). This will then be used to create a mask to trim the Raster 
files and to clip the shape files. As such no new data is required. 

 

Selected Data 
 

Data Source Type Description 
Population ERSI Point Features/Attribute Table Number of People in a City 
Elevation USGS EarthExplorer Raster ASTER 

City ERSI Point Features/Attribute Table Points with Attributes 
Outline ERSI Shapefile Within UK outline 
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ADDING DATA 
 

Firstly the European base map data from the ERSI disk was added to the directory in ArcMaps. The add data 
button ( ) was then used to add it to a blank map document. This included the raw data needed for city 
positions, population calculations and the outline of the Isle of Wight. It projected in GCS WGS 1984 (Figure 
9). 

Secondly the two Aster .tif elevation files needed to 
give coverage over the area of interest were added. 
This was done by the same procedure listed above. 
When the data was added a window popped up (Figure 
10) all default values were left and the pyramids were 
generated. This was done for both files. The data was 
the projected on the fly. To see if this was done 
correctly the project raster tool was used to project the 
.tif into GCS WGS 1984, it projected identically to the 
on the fly projection. The alignment of the coastlines 
was manually checked when zoomed in to a great 
extent and was deemed satisfactory (Figure 11). 

 

 

 

 

 

Figure 11:  A layout view giving a sense of the alignment of 
the two projected data files.

Figure 10:  Pop up window asking if “Would like to create 
pyramids?”

Figure 9:  The data frame properties after loading the ERSI 
base data.
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DATA PREPARATION 
 

Mosaicking the ASTER files 
 

First the “Mosaic to New Raster” tool was selected (Left of Figure 12). Then within the “Mosaic to New 
Raster” window the two .tif files were chosen as the input rasters. The rest of the window was filled out as 
shown in Figure 12. For all the sections in the “Mosaic to New Raster” window, the values for the input 
rasters (which had all the same values for this purpose) were looked up and entered (top right of Figure 12). 
After this tool was run the original two tiles were removed, as they were no longer needed. 
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Figure 12:  The windows used to Mosaic the two ASTER Elevation files together. 
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Extracting the Outline 
 

Before anything else was performed it was important to extract the outline so that everything else could be 

cropped with respect to it. Firstly the Attribute Table was opened for “Country Outlines” and the United 
Kingdom of Great Britain polygon was selected (Figure 13). 

 

This was then exported as a new shapefile (Figure 14, 15 and 16) and displayed in the table of contents. The 
result was a shapefile containing the outlines of all part of the UK. The exported data was then added to the 
map by responding “Yes” when asked “Do you want to add the exported data to the map as a layer?”. 

The next step was to extract the outline of the Isle of Wight from this new shapefile. 

 

 

Figure 13:  The  table of contents for “Country Outlines” showing the selected United Kingdom of Great Britain polygon.
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Figure 14:  A screenshot in Data View showing the how to open the “Export Data” window in figure 15 to export the UK Outline from 
the “Country Outlines” file.

Figure 15:  The “Export Data” window. “Export: Selected 
features” (the United Kingdom outline) was chosen. It 
could have been exported in the same coordinate system 
as either “the layer’s source data” or “the data frame” 
since they were the same but “the layer’s source data” 
was used. Choosing the “Output feature class” is shown 
in Figure 16.

Figure 16:  The “Saving Data” window showing the data was saved in 
the GIS project folder as UK_Outline.shp. It was saved as a shapefile 
since it is only needed to define containment.
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First the polygon in the “UK_Outline” layer was selected. This was done by right-clicking on it in the Table of 
Contents and opening the “Attribute Table” and clicking to the very left hand side of the polygon (Figure 17). 

 

It is the necessary to separate this polygon into its more basic components, including the Isle of Wight 
outline. This is done via the editing, and advanced editing toolbars. These toolbars were opened via 
Customize > Toolbars > Advanced Editing and Customize > Toolbars > Editing. Editing was then started by 
going to the “Editing” drop down in the “Editing” toolbar and selecting “Start Editing” (Figure 18).  

 

 

 

 

 

Figure 17:  The selected polygon in the Attribute Table. The orange box marks where was clicked to select this polygon.

Figure 18: A screenshot showing how to “Start Editing”. Firstly follow the steps illustrated on the left. Then as shown on the 
right select “UK_Outline” and press “OK” to start editing that layer.
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Once “Start Editing” had been applied to the “UK_Outline” it was checked that the “UK_Outline” polygon was 
selected, if it was not the steps in Figure 17 were followed to select it. Once this was done “Explode Multipart 
Feature” ( ) was selected from the “Advanced Editing” toolbar. Then edits were saved by returning to the 
“Editing” drop-down and selecting “Save Edits” (Figure 19). The Attributes Table for “UK_Outline” was then 

revisited to check there were now 1518 
polygons. The attributes table was then closed 

“Select Features Tool” ( ) was selected. It was 
then used to select the polygon representing the 
Isle of Wight’s coastline by clicking near the 
outline of the Isle of White (to make this visible 
the “UK_Outline” layer was dragged to the top of 
the Table of Contents. The result is shown in 
Figure 20. 

 

The same steps shown in Figures 14, 15 and 16 were then followed to export the Isle of Wight outline as a 
new shapefile. The resulting layer was saved as “IOW_Outline”. 

When asked “Do you want to add the exported data to the map as a layer?” “Yes” was the response. 

 

Figure 19: How to “Save Edits”

Figure 20: A screenshot showing the result of selecting the Isle of Wight outline in the newly “Exploded” “UK_Outline” layer.
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Keeping Data Organized 

The “Country Outlines” or “UK_Outline” layers were no longer needed since they were intermediate files to 
obtain the Isle of Wight Outline shapefile. They were removed by right-clicking on the layer in the Table of 
Contents and clicking “Remove”. 

The “IOW_Outline” was then renamed by double clicking on the layer in the Table of Contents to open the 
“Layer Properties” window and selecting the “General Tab” then by editing the text in the “Layer Name” field 
to “Isle of Wight Coastline”.  

At this point a new data frame was opened (Insert > Data Frame) and was named “Isle of Wight Today”. The 
“Isle of Wight Coastline” Layer was then dragged and dropped from the original data frame into the new data 
frame (“Isle of Wight Today”) in the Table of Contents as was “Europe Base Map” and “IW_Elev_Mos”. The 
old data frame was removed by right clicking on it in the Table of Contents and pressing “Remove” The result 
is shown in Figure 21.  

 

Figure 21: The new Data Frame active containing the outline of the Isle of Wight, the locations of cities and their populations for 
the whole of Europe and the untrimmed elevation raster. Also showing the old “Europe Base Data” data frame minimized.
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Trimming the Data  
 

The data now needed to be trimmed to the outline. This helps the program run faster during operations since 
you can remove huge amounts of unrequired data. This will be done via processes called clipping extracting 
by a mask. 

Trimming the Elevation Raster 

Before any tools can be used the “3D Analyst” and “Spatial Analyst” extensions needed to be turned on. This 
was done via Customize > Extensions and then ticking the boxes accordingly. 

Next the “Extract by Mask” tool was applied to the IW_Elev_Mosaic (Mosaicked Elevation Rasters). This was 

found via ArcToolbox ( ) > Spatial Analyst Tools > Extraction > Extract by Mask. The fields were filled out as 
shown in Figure 22.  

 

 

 

 

 

 

 

 

 

It was also necessary to change the Environments settings to those shown in Figure 23. Since the unclipped 
elevation data is no longer needed this is removed from the Table of Contents. The result is shown in Figure 
24. 

Figure 22: The “Extract by Mask” window. The output was called Elevation and saved to an appropriate location. The orange 
box marks where to open the “Environment Settings” window in Figure 23.
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Figure 23: The “Environment Settings” window. The mask was set to Isle of Wight Coastline and the cell size was kept 
consistent with the input data.
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Figure 24: A screenshot showing the result of the “Extract by Mask” tool. Notice the orange box showing how the Table of 
Contents has lost the now removed “IW_Elev_Mos” and gained “Elevation”.
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Trimming the City Data 

First the “City Points” and “City Areas” layers were taken from being subsections of “Europe Base Map” and 
placed independently in the “Isle of Wight Today” data frame, as was the “Background” layer since this will 
be needed later (See Page 26) (Figure 25). “Europe Base Map” was then minimized since it was not needed.  

 

Next the “Clip (Coverage)” tool was used on “City (points)”. This can be found via ArcToolbox ( ) > Analysis 
Tools > Extract > Clip. As shown in Figure 26 the two cities coverages are made up of layers. Each of these 
layers was clipped individually (Figure 27). This process was repeated for each layer in both city coverages.  

 

 

 

 

 

 

 

 

 

 

Figure 25: A series of screenshots showing the reorganization of the Table of Contents from Left (Before) to Right (After).

Figure 27: A screenshot of the Table of 
Contents showing the sublayers within 
each city Layer. Figure 27: The  “Clip” window. Showing how the “Tiny Village” layer was clipped 

with respect to the “Isle of Wight Coastline”  
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During this process some of the layers being clipped returned an output containing zero values. This meant 
that there were no cities of that type within the outline. As a result that layer is not of interest for this project 
and can be removed (i.e. “Small City”, “Medium City” , “Large City”, “Capital City”, “Urban Areas (under 5 
km)” and “Urban Areas over 5 km)”). The newly generated layers were then moved below their parent layers 
in the Table of Contents, they were then renamed as were the coverages and the old layers removed. 
(Figures 28). 

 

 

N.B. All the files that have been removed still exist in well-organized folders. They are simply no longer being 
displayed in the Table of Contents. 

 

 

 

 

Figure 28: A series of screenshots 
from left to right showing the 
progression of the Table of Contents 
after clipping.
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Presentation 
 

Before any more processing of the data was performed it was useful to resymbolize the data. Since this had 
to be done eventually and it makes the data more pleasant to work with. 

First the “Europe Base Map” data can be turned off ( ) since it is no longer of interest. This was also 
done with the “Background” coverage. The “Ocean Background” layer was then moved from within the 
“Background” coverage to be an independent layer in the Table of Contents and renamed “Sea” (Figure 29). 

At this point the “Railway Station” layer was removed from the TOC since it contained no population data 
and was therefore irrelevant. 

 

 

 

 

 

 

 

 

 

 

 

Figure 29: A series of screenshots from left to right showing the progression 
of the Table of Contents as the relevance of data is evaluated.
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Symbology 

Symbology of layers was changed by double clicking on a layer in the TOC and navigating to the “Symbology” 
tab. From here the Point, Line and Polygon features (The “Cities”, “Urban Areas”, “Sea” and “Isle of Wight 
Coastline” layers) can be changed via the symbol section (Figure 30). The results are shown in Figure 31. A 
reference scale was then set for the “Isle of Wight Today” data frame (1:150,000). 

 

 

 

 

 

 

 

 

 

 

 

 

 

It was then necessary to change the symbology of the “Elevation” layer. Then as in the previous step the 
layers were double clicked and the “Symbology” tab selected. From here to make the elevation an attractive 
and informative background for the landmass it was resymbolized to the “Elevation #2” Color Ramp (Figure 
32). 

 

 

 

Figure 30: The “Layer Properties” (Left) and “Symbol Selector” (Right) 
windows showing where and how to change the symbology.
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Figure 31: Screenshots of a section 
of the Isle of Wight showing the 
new symbology (Left) and of the 
table of contents after changing 
the layers symbology.
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The “Urban Areas” Layer was later resymbolised to be 50% Transparent (Adjusted via the “Display” tab after 
double clicking the layer) and the outline and fill colors changed (Figure 33) 

Labels 

Although the labels were not ideal at this stage it was decided to leave them as they were; anticipating that 
later the labels would need to be changed again. In adjusting them they would need to be changed to 
“Annotations”, when the city layers were later split in to those above/below sea level these annotations 
would not be linked to these groups. 

 

 

Figure 32: Screenshots of a section of 
the Isle of Wight (Same as in Figure 
31) showing the new symbology of 
the “Elevation” layer (Left) and of the 
table of contents after changing the 
“Elevation” layers symbology.
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Creating a Hillshade 

The final step in improving data presentation was to create a hillshade using the “Elevation” layer. This was 
done via the “Hillshade” tool (again here it was important to check the relevant extensions were active as in 
“Trimming the Data” – “Trimming the Elevation Raster”). The “Hillshade” tool was located by ArcToolbox > 
Spatial Analyst Tools > Surface > Hillshade.  The parameters entered to do this are shown in Figure 33.  

 

 

This “Hillshade” layer was then moved above “Elevation” in the Table of Contents. It’s symbology was then 
changed as before, but with Color Ramp to “Pink to YellowGreen Diverging, Bright” and transparency to 50%. 
The result is shown in Figure 34. 

 

Figure 33: The new “Urban Areas” symbology (orange box) and the “Hillshade” window and the parameters entered to create 
the hillshade. Z factor 0.000009 was used to convert from the X-Y units (Decimal Degrees) to the Z units (Meters).
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Figure 34: A screenshot showing the new appearance after the hillshade has been applied.
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Combining the City Layers 
 

Before adjusting sea level and calculating population displacement it is important to place all the Urban 
Points (those under the Cities section) into one layer. This was done using the “Append” tool (ArcToolbox > 
Data Management Tools > General > Append). As shown in Figure 35.  The old layers were then removed and 
the new appended dataset renamed “Places” The result is shown in Figure 36. 

 

 

 

Figure 35: The “Append” window which was used to append the “Small Village”, “Tiny Village” and “Town District” datasets to the 
“Village” layer.
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Figure 36: Screenshots of a 
section of the Isle of Wight (Left) 
and of the table of contents after 
changing the “Appending” the 
urban point layers together.
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Adjusting City Data Tables 
 

A Note on Project Scaling 

When calculating the total populations under sea after adjusting the sea level each city needs a discrete 
population. For the purpose of this exercise this will be performed by manually creating a new field in the 
“Places” Attribute Table as outline below. To perform this on a larger scale you would enter the Attribute 
Table right click on the new field (AVG_POP) and select field calculator. This could then be used to 
automatically fill the new field as the median value of the existing POP_CLASS field. 

Creating a New Field 

Each place has a corresponding population range (Figure 37).  

To allow for later data analysis it was necessary to create a new field containing the median of the population 

range. This was done by clicking “Table Options” ( ) from within the “Table” window (Figure 37) and 
selecting “Add Field..”. From the “Add Field..” window a new “Long Integer” (Short integer limits the field to 4 
figures this was not sufficient) field was created called “AVG_POP” (Figure 38). 

 

 

 

Figure 37: The Attribute Table for the “Places” layer before adding the new field. Highlighted in orange is the “POP_CLASS” 
field. 
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Next editing of the “Places” layer was initiated. (Editor 
Toolbar > Start Editing and select the “Places” layer). 
Then within the Attribute Table the “AVG_POP” field 
values were manually changed to the median values 
of the “POP_CLASS” field (Figure 39). Edits saved and 
Stopped (Editor Toolbar > Dropdown > Save Edits/Stop 
Edits). 

 

 

 

 

 

 

  

 

 

 

Figure 38: The “Add Field” window, showing the creation of the 
AVG_POP field for the “Places” layer.

Figure 39: The “Places” Attribute Table after the new field had been created and filled (orange box). 
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METHOD 
 

General Method: 

 

 

For this project a series of figures and accompanying statistics were produced for various changes in sea 
level. Outlined in this section is the method for producing one for a 15 increase, it is worth noting this can be 
followed near exactly for the other values. 

Choose Magnitude 
of Sea-Level Rise 

Input original 
"Elevation" raster

Reduce all values 
by chosen 

magnitude using 
"Raster Calculator"

Generate a contour 
using the 

"Contour" tool for 
all values > 0

Symbolize interrior 
of contour os land 
all other values as 

water

"Select by 
Location" all Cities 
that are not within 

the contour

Export this as a 
new Layer 

View and record 
statistics for layer  

(i.e. Total 
Poulation)
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MAP CREATION 
 

Increasing Sea Level 
 

For each sea level change a new data frame was created (Insert > Data Frame) and named Xm where X is the 
rise in sea level to be calculated. All the files from the “Isle of Wight Today” where then copied across and the 
“Isle of Wight Today” data frame was minimized for convenience. 

This was done via the “Raster Calculator” tool (ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster 
Calculator). The tool was used to reduce all values of the “Elevation” raster, effectively raising sea level by 15 
meters (Figure 40). 

 

Having created this new raster it was necessary to represent all values now below zero as sea. To do this the 
“Raster Calculator” was again used. This time a conditional statement was input (Figure 41) which created a 
new binary raster with all values greater than zero (land) able to be symbolized separately from those equal 
to or less than zero (the sea).  

 

 

Figure 40: The “Raster Calculator” window showing how it is used to generate a new elevation raster in which sea level has 
risen 15m. This new file was saved as Elev_Sub_15 (For each increment the Elev_Sub_X format was conserved)

37 
 



 

Aesthetics 

The 15m data frame then had “Elevation”, “Hillshade”, “Background” and “Europe Base Map” removed. A 
new hillshade (Hillshade_15) was generated as outlined earlier (Data Preparation – Presentation – Creating a 
Hillshade p. 30-31). Both “Hillshade_15”and “Elev_Sub_15” were then resymoblized as before (Data 
Preparation – Presentation – Creating a Hillshade/Symbology p. 26-31). Binary_15 was then resymbolized 
such that the new 1 values are represented by the same blue as “Sea”. These new rasters were renamed 
appropriately and the Table of Contents reorganized (Figure 42). The resulting Table of Contents and Map are 
visible in Figure 43. 

 

 

 

 

 

 

 

Figure 41: The “Raster Calculator” window showing how it is used to generate a new binary raster in which any cells corresponding 
to values of less than or equal to zero in the “Elev_Sub_15” raster will be assigned the value, 1 (Sea) and all other cells assigned 
the value, 0 (Land). For each increment the Binary_X format was conserved.
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Figure 42: The evolution of the Table of Contents for the 15m rise data frame.

Figure 43: How the map looked after raising sea level 15m.
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Generating Statistics 
 

First it was necessary to separate the “Places” that were now below or at sea level from those 

that were not (Figure 44) 

 

Creating a Contour 

The “Contour” tool was used (ArcToolbox > Spatial Analyst Tools > Surface > Contour) to generate a contour 
at elevation zero (Figure 45). 

 

Figure 44: The method for separating places above and below sea level.

Create A 
contour at 0m 

Elevation

Select "Places" 
within the 

contour

Export as new 
layer and delete 

from "Places"

Figure 45: The “Contour” window. The base contour was chosen as 0 and an interval of greater that the range of the data. 
This was so that only the “Base contour” will be generated.
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Correcting for Misalignment 
 

The problem 

It became clear at this point there was a problem with this method. The contour generated did not form a 
complete loop. This was because when the elevation data was trimmed to the Isle of Wight outline it 
trimmed some of the data that the elevation raster recorded was above sea level. As a result, along some of 
the cliffs where there were horizontal misalignments/accuracy issues between the outline and elevation 
raster the value at the edge of the raster is positive to a large extent. As a result of this even after subtracting 
15m from the raster there are still regions on its edge that have a positive value. Due to this and containment 
analysis as is needed for the population calculation is impossible. 

The solution 

To solve this problem all steps were repeated after generating a new outline. This outline was generated by 
trimming the raster to a polygon as explained below and then creating a zero elevation contour as explained 
above. As a result this outline by definition was perfectly aligned with the Elevation files coast. From this point 

onwards all images and maps are generated using this outline. 

Generating the Trimming Polygon 

A new ArcMap file was started. The data was reloaded as shown in 
Figure 46. The “iw_elev_mos” file was added.  

To trim this raster it was necessary to create a polygon that only 
encompassed positive values from the Isle of Wight but included all 
such positive values. This was done visually. 

First ArcCatalogue was opened and File > New > Shapefile was used. 
The Shapefile was named “Outline_Trim” and was created for the 
“Polygon” feature type (Figure 47). 

This file was then added to the ArcMap data frame using the add data 
button ( ). 

Editing was then started (As outline previously) on the new shapefile. 

“Create Features” ( ) was selected. Then from the “Create Features” 
window “Polygon” was selected (Figure 48). Points were then carefully 
manually picked such that all positive points on the Isle of Wight were 
included but no other positive points were (Figure 48). “Finish Sketch” 
was then selected (Right Click > Finish Sketch) (Figure 48). 

Figure 46:  The new files table of 
contents. Notice that old obsolete files 
have been removed and the 
“iw_elev_mos” has been added.
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This shapefile was then used to trim the 
“iw_elev_mos” raster as outlined previously (Data 
Preparation > Trimming the Data > Trimming the 
Elevation Data”). The only difference that the file it 
was trimmed to was not the “Isle of Wight Coastline” 
file but rather the new “Outline_Trim” polygon. From 
here all previously procedures involving the outline or 
outline derived files were repeated. 

 

 

 

 

Figure 48:  The creation of the “Outline_Trim” polygon. “Create Features > Polygon” and “Finish Sketch” are both shown in 
orange boxes.

Figure 47:  The “Create New Shapefile” window used to 
create the new shapefile “Outline_Trim”. 
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Steps: 

 

 

 

 

 

 

 

 

 

 

 

 

Select the Elevation 
Raster

"Extract By Mask" 
Raster Using 

"Outline_Trim"

Create Contour at 
Zero Elevation

"Extract By Mask" 
Raster Using New 

Contour

"Clip" Other Data to 
Contour

Manually Check 
"Places" file includes 
all places in Contour

Use Existing Places 
File

Create a Hillshade 
and Adjust 

Symbology as Before

Use "Raster 
Calculator" and 

"Contour" to Raise 
Sea-Level
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Below are two figures showing the results before and after a 15m rise in sea level (Figure 49). 

 

At this point the project is back at the same stage as it was before it was decided that the outline needed to be 

recalculated. 

 

 

 

 

 

 

Figure 49:  Top: Appearance before sea level rise. Bottom: Appearance after 15m rise in sea level. Please sea final handouts 
for a better representation,

44 
 



Generating Statistics Continued 
 

Calculating Population Displacement 

To calculate how many people’s homes have become below sea after the rise it is necessary to select by 
location. First the “New Sea” binary raster (showing the difference in water extent) must be converted into a 
polygon. This is done using the “Raster to Polygon” tool (ArcToolbox > Conversion Tools > From Raster > 
Raster to Polygon) (Figure 50). 

 

“Select by Location” ( Selection > Select by Location) was then used to select all “Places” contained within the 
“Containment Polygon” (Figure 51) since it represents the parts of the Isle that are now under sea.  

 

 

 

 

Figure 50:  The “Raster to Polygon” window showing how the “New_Sea_Polg” polygon was created. This was then renamed 
“Containment Polygon” since it is used to establish which cities are now under sea. 
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The Attribute Table was then opened for 
“Places” (Right Click > Attribute Table). The 
“Show selected records” tab was used to 
view the underwater places.  

Then the “Statistics” window was then 
opened (Selection > Statistics). The “Places” 
layer was selected and the field was defined 
as “AVG_POP” (Figure 52). The window then 
returned various statistics about the selected 
places (those under water). The “Sum” was 
then recorded since this represents an 
estimate for the total number of people 
displaced by the given sea level rise.  

All data in the Attribute Table was then 
manually selected by returning to the “Show 
all records” tab and clicking the top records 
then holding shift and clicking the bottom 
record. Selection statistics was revisited and 
the “Sum” recorded.    

 

 

 

Figure 52: Top: The “Places” Attribute Table showing the newly selected underwater places. Bottom: The “Selection Statistics” 
window showing how statistics were obtained a given selection, in this case the places underwater after a 15m rise in sea 
level.

Figure 51:  The “Select by Location” window, showing the 
parameters used to select all the “Places” now under water.
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Calculating Change of Area 

To calculate the original area the Elevation rasters the attribute table was opened and all the data was 
selected. Selection > Statistics was then used to view the “Sum” of all the count values (The number of cells 
in each row). This gives the total number of cells. This can then be multiplied by the area of a cell (30m by 
30m = 90 m2) 

 The result was:  

Original Area of the Isle of Wight = 637666 x 90 = 57389940 m2 = 57.38994 km2  

The value after the raised sea level is simply this subtract the value of the “Sea Change” binomial raster. 
Which is calculated in the same way  

Area after 15m Sea Level Rise = 57 389 940 – (83009 x 90) m2 = 49.919130 km2 

The percentage change was therefore: 13.02% 

 

Results 
 

Population 

It is estimated by the method outlined above that due to a 15m sea level rise 16, 500 people would have 
been displaced. That is 25.19% of the original population (65,500).  

Land Area 

It is estimated that 13.02% of land would be lost by a 15m sea level rise.  

 

 

 

 

 

 

 

 

47 
 



Producing the Map 
 

Creating a New Field 

The main notable step in producing the layout was the addition of a new field to the “Places” Attribute Table. 
This field was created as a ”Text” field called “Underwater” field in which Y or N could be entered to 
represent Yes or No respectively (Figure 53). The underwater places were then selected as before (Map 
Creation – Generating Statistics Continued) and after turning on editing for this layer (Data Preparation –
Extracting the Outline p.18-19) the values were manually entered and edits were saved and stopped. This 
then allowed the places to be symbolized by whether they were submerged or not. 

The Reference Image 

A new data frame was created and the original “Europe Base Map” file loaded to create the reference image 
of the UK. The area of interest box was added manually by creating a new shapefile in ArcCatalogue and then 
Add Features > Polygon (Map Creation – Correcting for Misalignment – Generating the Trimming Polygon p. 
41-42) 

General 

Other than the new “Places” field some symbologies were adjusted as were a few names. Also some of the 
labels were converted to annotations (Right Click > Convert Labels to Annotations) If there are any parts of 
this process that you would like addressed further feel free to contact me at: A.l.e.x_R@Hotmail.co.uk 

 

 

 

 

 

 

 

 

 

 

 

Figure 53: The “Add Field” window, showing the 
parameters used to generate the “Underwater” 
field which allowed for differential symbolizing of 
places above and below the sea.
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FUTURE STUDY AND SCALING 
 

How to improve/further the study: 

Population Data:  

 Acquire data with exact city populations or  
 Acquire raster data with population coverage across total area of interest. 

Contouring: 

 Include an additional step in processing that would only allow points below sea level and 
connected by other such tiles to the previous extent of the sea. 

Erosion: 

 Include a method for estimating erosion since this will also effect populations, for example 
eroded cliff will likely not be overcome by the rising sea but might erode into it. 

Population Growth: 

 Try and account for how populations may change during the time it takes for the given 
change in sea level. 
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CONCLUSIONS 
 

Roughly 25% of the population in cities were displaced by a 15m rise in sea level. However, due to the 
limitations of this study it is difficult to extrapolate the potential effects on world populations. The small 
sample size is a major factor. This will produce skewed results for a variety of reasons as listed below. 

 

Potential Sources of Error for Extrapolation: 
 

• Island Area – This creates a larger coast to interior ratio, meaning a larger proportion of the 
population were located on the coast compared to global distributions. 

• Elevations – Elevations in such a small area are unlikely to be representative of the world. For 
example the effect of this experiment on Bangladesh or the Netherlands would be significantly 
different due to their low relief. 

 

Scaling and Future Study 
 

A future study could address this issue over a much larger area. This would give a larger sample giving more 
statistically valid results. There should be no issues with scaling this project other than creating some code to 
auto-fill the field in Data Preparation > Adjusting City Data Tables. Though, this is not necessary if a 
population raster can be found and used. In fact all data needed to scale this project to the whole of Europe 
is available from the sources listed. 

 

 

 

 

 

 

 

 

 

50 
 



 

 

 

51 
 


	Introduction
	Data evaluation
	What was needed?
	Choosing Population Data
	Choosing Elevation Data
	Choosing City Data
	Choosing an Outline

	Data Analysis
	Refocusing the Project
	Selected Data

	Adding Data
	Data preparation
	Mosaicking the ASTER files
	Extracting the Outline
	Trimming the Data
	Presentation
	Combining the City Layers
	Adjusting City Data Tables

	Method
	Map Creation
	Increasing Sea Level
	Generating Statistics
	Correcting for Misalignment
	Generating Statistics Continued
	Results
	Producing the Map

	Future Study and Scaling
	Conclusions
	Potential Sources of Error for Extrapolation:
	Scaling and Future Study


